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Disclaimer

MOSS Systems Limited are continually improving the quality of their
software. Therefore they reserve the right to make changes both to
the software and the documentation without notice.

The information in this publication is as accurate as possible but
MOSS Systems cannot give any warranty that the software is free
from errors or that it will meet every requirement of all users. It is the
user’s responsibility to satisfy himself that the software is suitable for
the purpose for which it was purchased.

The software described in this publication is subject to a licensing
agreement and may only be used in accordance with the terms of
that agreement.
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Chapter 1 Introduction

Introduction

Structure

This manual is for regular users of MOSS. It explains all the facilities
available in MOSS, and provides the data you need to use them in various
applications.

MOSS is described in terms of its major options (in MOSS, facilities

accessed by commands are called ‘options’). The chapters feature the

engineering options in the broad sequence that you would use them in an

engineering design:

e for creating a model of the existing surface and perhaps sub—surfaces

e for developing surface models of new works, and for analysing and
comparing these with the model of the existing surface

e for producing contract information, including drawings.

This approach works well because most of the options perform a specific
engineering task.

However there are some options that perform general or house—keeping
tasks and these are documented in Chapter 2: ‘Throughout MOSS’, ahead
of the chapters for the engineering options.

The overall sequence of the manual is:

Part 1: Introduction

Chapter 1:  Introduction

Introduction
Help on HELP

Chapter 2:  Throughout MOSS.

Graphics

Linemode

Models and the DPF
General information
General options
Global minor options

Chapter 3:  Drawing options
Major option NEWDPF
Major option NEWRPF

Major option DRAW
Major option ENHANCE
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Major option CLIP
Major option LAYOUT
Chapter 4.  General options

Major option EDIT
Major option REPORT
Major option COPY
Major option AREA

Part 2: Engineering Facilities

Chapters 5 —14 cover the engineering options in the order that you would
use them in a typical engineering design, in the sequence:

Chapter 5:

Chapter 6:

Chapter 7:

Chapter 8:

Chapter 9:

Chapter 10:
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Major option SURVEY
Major option SETOUT
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Vertical element
Vertical IP
Vertical spline

Selection methods
Railway

Associate alignments
Non Interactive alignment
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Major option VALGN
Major option VCUSP

Geometric design

Major option DESIGN
Major option INTERFACE
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Major option TRIANGLE
Major option SECTION (177/178)
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Appendix 1:
Appendix 2:
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Appendix 6
Appendix 7
Appendix 8
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INTRODUCTION

Format and conventions

The main features of the new formats and conventions are as follows:

Minor option have standardised names (short versions of their
descriptions)

There is a fixed sequence of information for each minor option:

Description
Input
Graphics
Linemode
Output

Any of the sub-sections above may be accompanied by Notes, marked
by a ¢ symbol and printed in italics to set them apart. Notes generally
feature information whose nature is cautionary, exceptional, or specific
to particular circumstances. The idea is that Notes qualify or modify the
information in the main description of the option.

Italics are also used to denote other specific types of information, as
follows:

- titles of other manuals or documents

Bold type is also used in specific situations, as follows:
- to denote hierarchy in margin sub-headings
- for first use of important terms
- for titles of figures.

The following menu presentation indicates that you will need to scroll
down the scrolling menu area to achieve the display shown.

Mandatory fields in Linemode are prefixed by an asterisk (*).
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Figure1-1 Scrolling menu diagram

The MOSS documentation set

This manual is the main reference document for the MOSS program, and is
the most comprehensive document in the whole documentation set.

The other documents of the set are:
e Introduction to MOSS

This booklet is for newcomers to MOSS. It describes the basic concepts
and principles behind MOSS, explains what you can achieve with it, and
outlines how to use it. It is intended to be read before using MOSS at a
workstation, perhaps in the week before attending the MOSS training
course.

It could also be useful to senior engineers who need to understand what
MOSS can do and basically how it works, though do not use MOSS
themselves.

e Getting Started with MOSS

This book helps new users to use MOSS at a computer workstation or
terminal. It describes the various ways to access MOSS, and follows with
step—by—step tutorial scripts showing how to create surface models, and
how to display and manipulate them.

e Quick Reference Guide to Linemode

This is for those who are familiar with the concepts and principles of MOSS,
know how to use it, but can’t remember the input data required for a
particular Linemode facility. It simply lists the type and sequence of input
data for each option.

e Installing MOSS

There is one Installation Guide for each workstation on which MOSS is
supported. Each guide describes how to install MOSS and how to perform
simple tests to confirm that the installation has been successful.

e MOSS Systems Manager’'s Reference

There is one System Manager’'s Reference for each workstation on which
MOSS is supported. Each guide describes how MOSS is configured and
how to administer and maintain the system.

e MOSS Guide to UPM

This book is for the experienced MOSS user and describes how to develop
and distribute User Programmable Modules (UPMs). The book details the
programming commands available in major option UPM as well as aspects
of UPM security and licensing.
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e Guide to MOSS Software fonts

This book is for System Administrators and describes how to create and
implement your own software font within MOSS. Users do not need to refer
to it, as the methods used to invoke software fonts in MOSS drawings are
described in MOSS User Manual.

e Release Notes

This document introduces the latest features and facilities available to users
of the MOSS System, and details all the changes made since the last major
release.
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Help on HELP

Introduction

Major option HELP provides in-context access to the MOSS document
collection and is accessed by selecting ‘Help’ from the static menu area. It is
a quick and easy method of opening the documentation at the page
appropriate to the subject you specify.

Major option DOCUMENT provides access to the full MOSS document set
from the Housekeeping menu or from Linemode by typing document. The
information accessed by both major options is identical.

The purpose of Help on HELP is to assist you in navigating successfully
through the MOSS documents within the MOSS document collection.
Successful navigation is fundamental in accessing appropriate information.

Navigation in paper books is something we all take for granted and have
learned by experience; we automatically use help by searching the index
and table of contents when other methods do not succeed. The problem
with electronic books is the lack of tactile guides such as bulk, division
markers and so on.

WorldView®™ which drives major option DOCUMENT, will run simultaneously
with other applications on a wide variety of workstations and PCs, enabling
you to access information without interrupting your workflow. You can print
individual document files or groups of files (called WorldView collections). In
addition, features such as search collection, indexes, tables of contents and
bookmarks allow you to find information quickly.

Navigation in electronic books requires some understanding of the
information structure - the way in which documents, books, collections and
libraries are used in the navigation hierarchy.

The purpose of Help on HELP is to assist you in navigating successfully
through the MOSS documents within the MOSS document collection.

Terminology

Library - this is the top level in the structure. One or more sub-libraries are
used to categorise a selection. For example; MOSS library, PaveMOSS
library. A full description of the library structure is shown in Figure 1 - 2
below. The library is accessed by a hot zone iconbutton where applicable.

Collection - this relates to a book. The term ‘book’ is not used, as
electronically there is no need to sub-divide books into volumes, sections,
chapters and so on. The MOSS User Manual and Quick Reference Guide
are individual document collections.

Meta-collection - A meta-collection is a combination of two or more
existing collections and isare used specifically for search purposes. For
example, you can combine the MOSS and PaveMOSS collections
permitting search functions across both. Meta-collections are created in the
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File New Meta-Collection menu. See WorldView Help for further instructions
on how to use meta-collections.

Document - this term is used to define a number of pages of information
contained in a single file. Theoretically there is no limit to the size of an
electronic document. Within a MOSS document collection, such as the
User Manual, each document relates to a single subject or MOSS major
option. This aids choice when reviewing the results of a full-text query as
the major option or area of the document collection is identified.

Table of contents - a navigation aid. In electronic document collections,
more than one table of contents may exist. For example, tables of contents
may be provided to give an overview and, at subsequent and lower levels,
tables of contents may be more detailed with greater focus.

Tables of contents do not include page numbers, but have hypertext links
which, when activated by a click of the mouse button, take you to the
selected subject.

Index - a navigation aid. Indexes do not include page numbers, but instead
have hypertext links which, when activated by a click of the mouse button,
take you to the selected subject.

Hyperlink &% - a navigation tool. When activated by a single click on the
icon with the left hand mouse button, the information to which it is linked is
accessed. The target of the hypertext link will be highlit using video
inversion when it is displayed.

0 TFhe-hyperlink symbolis-shown-as = on PG hardware-

The MOSS library

The MOSS library is a list of collections or groups of collections. These
collections are grouped to reflect MOSS products, or the needs of
individuals such as System Administrators.

Library structure

The MOSS library is continually being expanded to ensure that all
information about new products and changes to current products is
available to you. Different areas of the library will have been created at
different times, and will therefore have different version numbers. Generally,
the version number is given on each library list, and within each document
on each page. Installation ensures that software and documentation are
kept in step, however, you should check and confirm that they are
compatible if you have any doubts

Different areas of the library will have been created at different times, and
will therefore have different version numbers. Generally, the version number
is given on each library list, and within each document on each page.
Installation ensures that software and documentation are kept in step,
however, you should check and confirm that they are compatible if you have
any doubts.-
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Introduction PC _
Applications Sun
User Guide HP/Apollo HP-UX
Installation VAXstation
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Alpha

Figure 1-2 MOSS Library structure

A knowledge of the library structure is only valuable if you can pre-
determine the location of information you require. If you are unable to locate
information easily, use the most appropriate Search facility. The Collection
Structure Browser uses a graphical interface to show a collection’s
hierarchical structure. It displays the titles of document containers and the
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titles of documents within those containers and from the Browser you can
cause any element of a collection to be displayed in WorldView. This facility
may assist you further in locating the required information.

WorldView Functionalities

Menus and Commands

WorldView commands are available on pulldown menus accessible from the
menu bar in the WorldView window. Commands can also be made into
icons on an icon bar for quicker access.

Customising WorldView Features

You can customise WorldView by setting parameters either directly in the
Iview file in your home directory (if you or your system administrator has
copied it there) or in the Preferences dialog, which changes the parameters
either temporarily or permanently, as you choose.

Because of the way in which WorldView is started by MOSS, you cannot set
parameters on the WorldView startup command line.

Accessing and Viewing Documents

WorldView displays documents up to 36 x 36 inches. The visible portion of
the document depends on the size and resolution of your display.

There are various ways to access documents for viewing. You can access a
single document or a collection of documents. Accessing a collection will
give you access to a Titles list. When you have accessed a document
collection, you can execute full-text queries to call up lists of documents
that contain specific information. Once you have opened documents, you
can follow hypertext links or bookmarks to other documents.

Hypertext Links

Hypertext links allow you to select and open a connected document
automatically.

Navigation between documents

Navigation throughout the collections provided by MOSS is achieved by
selecting button icons.

In the top left corner of each page of a MOSS document are two icons
(except in small documents where contents and index are inappropriate).
These aid your navigation out of the document and back to the library and
are shown below.

The library icon on the contents page of each collection returns you through
the current collection library to the MOSS library.

MOSS User Manual V10.5



Contents

CHAPTER 1
HELP ON HELP

Index

‘ Contents page of current collection or document
| Index of current collection

Contents Index

Figure 1-3 MOSS collection button icons

Navigation within documents

To move around a document you can:
e use the keys marked PGUP and PGDN on your keyboard

¢ use the vertical scroll bar on the right hand side of the document window
to scroll up and down and the horizontal scroll bars at the bottom of the
window to scroll across the page

e use the mouse to select the previous page, next page, first page and last
page and go to a selected page.

You can zoom in and out of the document by using the zoom commands
under the View pulldown menu and you can also size the WorldView
window by clicking on a corner of the window frame and dragging it out or
in.

Window Options

You have the option of opening each document accessed in WorldView in a
new window or of reusing the current window. You can also choose to

resize the document window to fit the document size or to keep the window
size fixed. Finally, you can duplicate any window and the document within it.
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Help functionality

The functionality available in both HELP and DOCUMENT are well
documented by the Interleaf WorldView product used for viewing the MOSS
documents. The following is an overview of the features available to you:

Menus and Commands

WorldView commands are available on pulldown menus accessible from the
menu bar in the WorldView window. Commands can also be made into
icons on an icon bar for quicker access. See Customising WorldView
features &

Printing
If your workstation is connected to a supported printer, you can print the
document you are viewing by executing commands from the Print dialog
box accessible from the File pulldown menu in the WorldView window. You
have the option to print the current page, a range of pages, or the entire
document.

¢ Some large documents within the MOSS collection are composed of a
number of smaller documents. This is not apparent when viewing the
collection, but when you select Print All you may not be able to print the
entire document in one go and will have to select each sub-document in
turn.

Simplifying print
An easier way of printing entire documents is to use the Bulk Printing
utility which is accessed from the MOSS library. This feature allows you to
print one or more documents in coherent sections of the User Manual,
Quick Reference Guide or UPM. Each main publication has been divided
into logical sections and the total number of pages and print file size of each
section is shown.

WorldView Help

WorldView Help is available through the Help pulldown menu in the
WorldView menu bar. Follow the hypertext links beside the items on the
Help Contents menu to find instructions for using WorldView features. You
can also search for key words in the Help collection.

Accessing and Viewing Documents

WorldView displays documents up to 36 x 36 inches. The visible portion of
the document depends on the size and resolution of your monitor.

There are various ways to access documents for viewing. You can access a
single document or a collection of documents. Accessing a collection will
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Navigating

give you access to a Titles list. When you have accessed a document
collection, you can execute full-text queries to call up lists of documents
that contain specific information. Once you have opened documents, you
can follow hypertext links or bookmarks to other documents.

When selected, Help opens a new WorldView window so that you can find
the information you require, and when you have found it, revert to the
previous window.

The Help window can be positioned anywhere on the screen to enable the
DOCUMENT window to be viewed. This is done by pressing and holding
the left hand mouse button whilst the cursor is positioned on the window
frame and moving the silhouette to the new position. When it is in the
required position, release the mouse button.

The Help pulldown has the following selections:

e Contents - opens a table of contents for the help

e Index - opens the index for help

e Search in Help - searches for words or phrases in the Help collection
e About WorldView - displays a copyright notice

To close the Help window, select the File pulldown menu and Close (Exit
will close down WorldView).

The page control panel located on the icon bar allows you to click on
buttons to go to the next page, the previous page, the first page, and the
last page, as well as to specify a particular page.

You can also navigate through documents using the scroll bars belonging to
each WorldView window. You can scroll to a new page or view different
parts of the same page (when the page is larger than your screen).

Window Options

Zooming

Printing

You have the option of opening each document accessed in WorldView in a
new window or of reusing the current window. You can also choose to

resize the document window to fit the document size or to keep the window
size fixed. Finally, you can duplicate any window and the document within it.

You can zoom a document to 50-200 percent of its original size. Zooming
larger is useful when you want to examine an illustration very closely or
when you want to enlarge the display of a small font. Zooming smaller is
useful when you want to see more than one page at a time on the same
screen. The Zoom Box allows you to zoom a specific area of a document

page.

If your workstation is connected to a supported printer, you can print the
document you are viewing by executing commands from the Print dialog
box accessible from the File pulldown menu in the WorldView window. You
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have the option to print the current page, a range of pages, or the entire
document.

Simplifying print

Searching

Notes

An easier way of printing entire documents is to use the Bulk Printing
utility which is accessed from the MOSS library. This feature allows you to
print one or more documents in coherent sections of the User Manual,
Quick Reference Guide or UPM. Each main publication has been divided
into logical sections and the total number of pages and print file size of each
section is shown.

There are two ways to search for a text string (a word, phrase or other
series of characters)

e Text search - a search backward and forward in the document you are
currently viewing, initiated from the Search Text pulldown menu

e Full-text search - a search across an entire collection of documents,
initiated from the Search Collection pulldown menu

There are three different types of full-text search: Standard for a single text
string or expression; Advanced for a query composed of two or more text
strings combined with search operators; Intuitive to find all documents within
a collection containing information related to a large block of text.

You can also search across a number of existing collections by combining
them into a meta-collection, created under the File pulldown menu.
However, before you can perform the search the .cfg (configuration) file
defining the meta-collection must be saved in a directory for which you have
write permission.

Also available under the Search pulldown menu are options to search for
hypertext links and notes.

By using WorldView notes you can record comments about the documents
you are viewing, save the comments electronically, retrieve them, and make
them accessible to other users. These may be observations, example input
files or a record of a problem reported to the hotline. You must have write
access to the notes file in order to create notes.

Notes files are ASCII files that contain the text of notes (and note icon
positioning information). They can be printed out at the system level to
provide hardcopy. They can also be moved to almost every text editor or
word processor, however all text format information will be lost.
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Bookmark List

Notes may be written to a specific directory, which you can set up using Edit
Preferences dialog. You can keep notes personal to yourself or make them
public to your network and fellow users.

WorldView also provides auto—display capability for notes, which opens
them automatically, whenever a viewer scrolls to the pages on which they
reside.

The Bookmark list provides a listing of each document marked during the
current viewing session. You can leave a document and return to a
previously marked document by choosing it from the Bookmark list. The
Bookmarks list is useful when tracking information about a particular topic
because you can mark each place that refers to a topic and return to it via
the list.

By setting a parameter, you can also save Bookmark lists between
WorldView sessions. Doing so gives you immediate access to documents
visited in a previous session.

Another method of moving between pages in documents is to use the View
Back command. This returns you to previously visited pages in sequence.

Hypertext Links

Hypertext links allow you to select and open a connected document
automatically. WorldView provides a default image for hypertext link
markers and you can also designate your own bitmap file to substitute
another image.

Customising WorldView Features

You can customise WorldView by setting parameters either directly in the
Iview file in your home directory (if you or your system administrator has
copied it there) or in the Preferences dialog, which changes the parameters
either temporarily or permanently, as you choose.

Because of the way in which WorldView is started by MOSS, you cannot set
parameters on the WorldView startup command line.

Further information on all functionality is available within WorldView Help.
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Chapter 2 Throughout Moss
Throughout MOSS

This chapter describes the facilities which are available throughout MOSS
and introduces some general principles. Some of the material is also in
Introduction to MOSS.

There are three main sections:

MOSS’s modes

Graphics mode
Linemode

UPM

Background mode

Models and the Draw Picture File

Objects and elements
Strings and string labelling
Subreferences

General information

Keyboard entry

Curve fitting

Discontinuities

Negative coordinates
Graphics selection methods
The parameter file

Error handling

MOSS’s modes

You communicate with MOSS through a set of commands which control the
input, manipulation, analysis and output of sets of data. The data
represents strings, points, and ultimately models.

The commands have a two tier structure, of major and minor options, in
which the majority of major options have a set of minor options nested
within them. The names of the major options reflect their function; for
example, EDIT, or COPY or REPORT. The minor options are always three
digit numbers in the range 000-999.

You can operate MOSS in any one of three modes:
e Graphics mode
e Linemode
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Graphics

Linemode

UPM

e Background mode

For the same data, each mode has its own method of input. You use the
mode that suits your level of expertise in MOSS or the complexity of the
data.

Graphics is the easiest and most effective mode to use. Text or graphics
menus lead you through sets of major and minor options, and the graphics
display enables a visual check on the soundness of your approach.

You communicate with MOSS using, first, a desktop ‘mouse’ to move the
cursor on the screen to select menu boxes, and second, the keyboard to
enter data into the boxes.

The results of your input are displayed instantaneously on the graphics
screen. You need a graphics screen for this mode.

The great advantages of graphics are:

e easy input (selecting from menus with a mouse)

e versatile graphics display for, say, highlighting errors

e immediate graphics display, giving greater efficiency and productivity.
There’s more about graphics in the next section.

The Getting Started manual contains an explanation of graphics mode and
provides a number of tutorial scripts as an introduction for a new user.

In linemode you enter data one line at a time. It is the method to use when
you are proficient in MOSS and the number of lines of input is relatively
small.

Linemode is described in more detail later in this chapter.

UPM may be used in both Linemode and IGmode.
In Linemode the UPMs may be designed to be interactive to obtain
essential input information from the user prior to processing.

In IGmode UPMs may be designed to use the Scrolling Menu Area, in the
same way as standard MOSS to obtain essential input information from the
user prior to processing.

Background mode

This mode is also known as Non-interactive mode. As in linemode, you
have a prepared set of data ready for submission on a line by line basis.

However, once the file of data is submitted to MOSS you have no further
control over the processing. You cannot watch the processing, as with the
INPUT facility. The data is processed, and the output is written to an output
file for later inspection.

Background mode is best for processing large data sets or where you
expect a long processing time, as with contouring a large model.
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Background mode will process a large data set while you carry on with other
work.

Initial entry to MOSS

To enter MOSS, type moss at the system prompt.
The system will ask you:

Do you wish to enter IGMODE, LINEMODE, UPM or Non-
Interactive.
(Type I, L, U, N, or FINISH to exit)

Type the letter corresponding to the mode you require, for example:

| <Return>

In this case, the graphics display will be loaded.

¢ if your response is | then MOSS goes immediately into IGMODE.

¢ if your response is L then MOSS goes immediately into LINEMODE.

¢ if your response is N then you will prompted for filenames etc. to run
MOSS non-interactively.

¢ if your response is U then you will taken to UPM in IGMODE.

Once you are in MOSS, you may switch between linemode and graphics
mode.

From graphics mode, select the LINEMODE box in the dynamic area at the
bottom of the screen.

From linemode, type the following:
IG, <DPF>

where <DPF> is the name of the Draw Picture File to be loaded. If this is left
blank, the default DPF draw.dpf will be used.

If a Raster Picture File of the same name as the specified DPF exists, this
will also be loaded.
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Graphics

Graphics is sometimes called IG mode or Interactive MOSS.

As computer technology and the MOSS system have evolved, the emphasis
has moved from graphics as a secondary process to graphics as the main
design mode. Many of the major and minor options of MOSS can now be
accessed directly through the graphics menus. Even options that appear to
have little influence on the drawings are included in the menus, so that you
don’t have to keep changing modes.

This section describes graphics mode, under the following sub-headings:
e Grouping of major options

e Overview

e The interactive graphics screen

e The static menu

e The scrolling menu

e The selection methods menu

e The dynamic menu

Grouping of major options

Graphics options
In graphics the major options are grouped as follows.
e Survey options

IDIGIT - Interactive digitiser
EDIT - Strings and points
COPY - Copy/move model data
REPORT - Models/strings/points

e Analysis options
AREA - Plan and slope
TRIANGLE - Triangulate/trim/group
SECTION - Extraction of strings
VOLUME - Section-based volume
SURFACE - Analyses and contours
PRISM - Prismoidal volumes
EDIT - Strings and points
COPY - Copy/move model data
REPORT - Models/strings/points

e General options
CREATE - Empty model
DELETE - Remove entire model
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RENAME - Change model name
EDIT - Strings and points
COPY - Copy/move model data
REPORT - Models/strings/points

e Design options
ALIGNMENT - H & V alignment design
SECTION - Extraction of sections
DESIGN - Feature strings
INTERFACE - Earthworks design
DRAINAGE - Networks and areas
EDIT - Strings and points
COPY - Copy/move model data
REPORT - Models/strings/points

e Drawing options
DRAW - Working drawings
DRAW - Contract drawings
ENHANCE - Add annotation
CLIP - Clip drawings
LAYOUT - Drawing sheets
MACROSYMBOLS - Create/amend/store
VIEW - Perspective/Photo
VISUALISE - Prepare EPIC data
NEWDPF - Select different dpf
NEWRPF - Select different rpf
2DDXF - DPF conversion to DXF
REPORT - Models/strings/points

e Housekeeping options
COMPRESS - Reduce modelfile size
SECURE - Stop inadvertent use
FREE - Remove security
RENAME - Change model name
REPLAY - Interactive replay
DOCUMENT - On-line documentation
REPORT - Models/strings/points

Overview

Using graphics
In graphics mode you use a desktop ‘mouse’ device to move a cursor on
the screen to select major and minor options from a series of clear simple
menus. Frequently used parts of the menus remain on the screen,
supplemented by scrolling menus. As you invoke each major option its
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associated minor options are displayed in menus. When you choose a
specific minor option the scrolling menus present a series of fields where
possible compatible with the standard input requirements of MOSS in
linemode. The essential difference is that you can graphically select data
from the screen, and that mandatory fields of data are automatically
prompted and individually highlighted as data is required for input. You can
enhance the menu structure of graphics mode still further by effective use of
some of the global facilities, available in the static menu areas.

Learning graphics

To help you appreciate the full functionality and flexibility of graphics mode,
a number of tutorial scripts and demonstrations have been prepared. The
examples have been pre-recorded and you can process them in a self-
teach manner with varying levels of intervention, using major option
REPLAY.

A typical learning exercise would be:

e Process a REPLAY example with no interruption to understand the
contents
being described.

e Process the same REPLAY example stopping each time a point needs
to be explained. The point will be explained either by an associated
script as in Getting Started, or through displayed text in REPLAY itself.

e Process the data yourself by keying/cursoring. By this stage you will
have gained sufficient confidence to try different data.

Ancillary facilities

It is not the intention of this section to describe the full range of graphics
facilities. However it is important to appreciate that the graphics
environment stretches beyond the interactive graphics menus. The following
are examples of other facilities:

e IDIGIT

e LAYOUT

e DISPLAY, PLOTTER
e MIFILE, MIDXF

¢ The options available within the graphics environment are not simply
restricted to those with direct graphical results.

¢ You can use OUTPUT to store alphanumeric information as a
permanent record for subsequent examination.

¢ Where graphical output is automatically generated, the style of
presentation may be governed by default DRAW macros stored in the
macrofile. You will only need to supply minimal data such as scales
through the scrolling menus.

¢ For some options, only simple operations may be directly available.
Nevertheless if you have a prepared data set of more complex options
these are easily processed using INPUT.
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The interactive graphics screen

Introduction

The opening screen display in MOSS'’s graphics mode is shown in Figure 2
- 1.

There is a lot to take in, but overall there are just four main parts to it:
e the graphics area (the picture)

e the menu areas

e the message area

e the keyboard area.

Throughout this manual, ‘display’ as a noun means picture, text, and
menus.

Graphics area

This is the rectangular area occupying most of the screen and displaying
the picture under consideration.

In graphics mode it always shows a graphical display. You can select the
feature in the display you want your next action to apply to, by moving the
screen cursor to the feature using a mouse, and clicking the mouse button.

Me